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A chave para o aumento da pene-
tração do Linux no mercado até 
agora não estava na dominação 

do uso generalizado do computador 
de mesa (o chamado desktop); em vez 
disso, alguns nichos foram sendo sis-
tematicamente atacados, notadamente 
servidores web, computação cientí-
fi ca e desenvolvimento de software. É 
indiscutível o grande sucesso 
dessa empreitada – nos últi-
mos tempos, o Linux se apos-
sou de inúmeros aspectos
da computação.

Uma das áreas em que o 
Linux não tem feito gran-
des incursões é a editoração 
eletrônica. Essa indústria 
permanece como uma forta-
leza quase inexpugnável do 
Macintosh, carro-chefe da 
Apple. Mas não precisa ser 
assim para sempre: após anos 
ignorando a área ou direcio-
nando usuários potenciais 
para aplicativos complexos 
e desajeitados como o LaTeX, 
o Linux fi nalmente tem algu-

mas excelentes ferramentas WYSIWYG 
(What You See is What You Get – o que 
você vê é o que você obtém) para edito-
ração eletrônica.

Neste projeto, produziremos quatro 
páginas de um jornal fi ctício com o 
Linux e as enviaremos para apreciação 
a David Hunter no departamento de 
pre-press do Belfast News Letter, o jor-

nal diário de língua inglesa mais antigo 
do mundo ainda publicado. Os progra-
madores podem considerar essa mini-
publicação como a “Hello World” da 
editoração em Linux.

Uma breve história da 
editoração
Antes do desenvolvimento dos sistemas 

WYSIWYG de editoração ele-
trônica, a produção de jornais 
e revistas era um processo 
complicado que envolvia equi-
pamento especializado como 
máquinas de linotipo, câme-
ras de processo e impressoras 
de brometo. A interface grá-
fi ca do Macintosh e seu apli-
cativo original de editoração, 
o Aldus PageMaker, mudaram 
isso para sempre. Finalmente 
o layout era acessível a todos, 
ao menos a todos que pudes-
sem comprar um Mac e uma 
cópia do PageMaker.

O domínio do PageMaker foi 
diminuindo até o ponto de se 
tornar um produto secundá-

Nesta primeira parte de uma série 

de três artigos, o ex-diretor de 

arte Jason Walsh discorre sobre 

editoração eletrônica no Linux. 

Jason criará um jornalzinho de 

exemplo usando o Scribus e outros 

aplicativos para Linux, testando-

os numa situação da vida real.

POR JASON WALSH

Diagramação no Linux com o Scribus

Um Jornal via Linux

Figura 1: Scribus rodando no Suse 9.1. Finalmente, a editoração de quali-
dade profi ssional chega ao Linux.
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rio, usado em larga escala por empresas 
para preparar newsletters. O principal 
aplicativo no mundo profissional da 
editoração eletrônica é o QuarkXPress. 
Milhares de  jornais, revistas e perió-
dicos em todo o mundo são produzidos 
no Quark; de fato, aqueles produzidos 
em outros aplicativos são raridade.

Dito isso, no fi nal dos anos 90 sur-
giu um sério desafi ante ao domínio do 
Quark, vindo da Adobe: o InDesign. 
Ele oferece a maior parte dos recursos 
encontrados no QuarkXPress, assim 
como muitos recursos que não exis-
tem no Quark, junto com a interface da 
Adobe, com a qual os designers já estão 
familiarizados graças ao uso do Pho-
toshop e do Illustrator.

Nem o Quark, nem o InDesign estão 
disponíveis para Linux, nem têm pre-
visão de estar tão cedo. Apesar do fato 
de que o Mac representa apenas 5% 
dos computadores desktop em uso no 
mundo, a Adobe e a Quark realizam 
50% de suas vendas nessa plataforma 

– o que indica o quão fi rme está o Mac 
como a plataforma de editoração eletrô-
nica. Tanto o Quark quanto o InDesign 
são aplicativos caros e profi ssionais fei-
tos para esse mercado e, até que o Linux 
faça incursões nessa indústria, não será 
do interesse da Adobe nem da Quark 
portar suas aplicações para ele.

Apresentamos o Scribus
Mas nem tudo está perdido. Da típica 
maneira Open Source, quando um apli-
cativo não está disponível, um grupo de 
programadores se une para criar uma 
alternativa livre. Essa alternativa é o 
Scribus (Figura 1).

Instalar o Scribus é razoavelmente 
fácil – infelizmente, não há nenhum 

pacote binário uni-
versalmente compa-
tível, mas compilar 
é bastante simples:

/ confi gure
make
make install

Em seguida, con-
f igure. Alternati-
vamente, há RPMs 
disponíveis para 
sistemas RPM como 
Red Hat/Fedora, Mandrake e SuSE. Gen-
too e Debian também possuem pacotes 
oficiais disponíveis nos respectivos 
repositórios emerge e apt.

PageMaker
Em nosso projeto, vamos trabalhar com 
requisitos pré-definidos, bem especí-
fi cos. O resultado fi nal serão algumas 
páginas de tablóide. O primeiro passo 
é defi nir a forma e tamanho da página, 
além de alguns parâmetros comuns: 
margens e colunas.

A Figura 2 mostra a caixa de diálogo 
Properties (Propriedades) do Quark-
XPress 6 no Mac OS X (Layout > Layout 
Properties). Se você vai converter um 
documento do Quark para o Scribus, o 
primeiro passo é copiar os dados básicos 
e digitá-los no Scribus. Se está criando 
um novo layout, defi na as propriedades 
equivalentes como necessário.

Por que não importar simplesmente o 
modelo original do Quark para o Scri-
bus? Seria bom se fosse tão simples. O 
Scribus não pode importar arquivos 
de outros aplicativos de layout. Como 
os próprios desenvolvedores dizem, 

“Arquivos em formato DTP são muito 
complexos internamente – provavel-
mente os mais complexos no PC. Criar 
fi ltros de importação e exportação é 
muito mais complicado do que importar 
uma planilha ou um arquivo simples de 
processamento de texto.

Esse é um certo impedimento, mas 
não é um problema incomum. O Adobe 
InDesign pode abrir arquivos do Quark 
4, mas não do 5 ou do 6. O Quark não 
pode abrir quaisquer arquivos do InDe-
sign, nem a versão 6 do Quark consegue 
salvar no formato da versão 4! Demons-
trando alguma antecipação e abertura 
que não se mostram nem no Quark nem 

no InDesign, o Scribus usa padrões 
XML para seu formato de arquivos 
nativo, o que signifi ca que será possível 
abrir arquivos Scribus em outros aplica-
tivos de layout no futuro. 
“Tablóide”, em termos americanos, em 

geral se refere a um tamanho de página 
específi co de 279,4 mm x 431,8 mm. Na 
Europa, tablóide é um termo mais geral 
que se refere a uma página de jornal 
mais ou menos de tamanho A3, metade 
do tamanho de uma folha inteira da 
mesma impressora. 

A caixa de diálogo New Document no 
Scribus é onde se cria a página padrão 
(figura 3). A página que estamos 
criando servirá de modelo para todas 
as páginas de rosto subseqüentes (na 
verdade, também para todas as outras 
páginas, embora numa forma leve-
mente modifi cada). Nossos modelos são 
muito básicos, defi nindo simplesmente 
a forma da página e se ela será voltada 
para a direita ou para a esquerda.

Nosso projeto tem 297 mm x 386 mm; 
levemente mais achatado que a maioria 
dos tablóides e mais ou menos seme-
lhante ao tamanho do jornal British 
Independent. Isso signifi ca que digita-
mos a largura da página como 297 mm 
e a altura como 386 mm. 

Imprimir até a extremidade da página 
(o que na indústria é chamado sangria) 
é comum em revistas, mas raro em jor-
nais, já que as impressoras em geral não 
são capazes disso. Mesmo quando é 
possível, nunca é adequado na primeira 
página. Precisamos defi nir uma área 
de impressão defi nindo guias de mar-
gem na caixa de diálogo New Document. 
Essas propriedades são defi nidas pela 
impressora e são diferentes em cada jor-
nal. Em nosso caso, as margens estão 
confi guradas como: Superior, 29 mm; 

Figura 3: A caixa de diálogo New Document no Scribus. Nessa caixa o 
formato básico da página é defi nido. Aqui utilizamos as confi gurações do 
EBO encontradas no arquivo original do Quark.

Figura 2: O menu Layout Properties no Quark-
XPress mostrando os padrões de página do East 
Belfast Observer.
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Inferior, 16 mm; Interior, 8 mm; Exte-
rior, 23 mm.

As margens são defi nidas de forma 
irregular para criar uma caixa retangu-
lar de  265mm x 340mm – essa é a área 
de impressão mínima em cada página 

– na posição correta.
Em algumas páginas, os itens podem 

fi car de fora do retângulo central; em 
outras, isso resultaria em itens que não 
seriam impressos. Esse problema de 
paginação e imposição de página, repe-
timos, deve-se à impressora e não ao 
profi ssional de diagramação; portanto, 
não vamos tratar o assunto em detalhes.

Dentro desse retângulo central, defi -
niremos mais tarde nosso layout princi-
pal de cinco colunas de texto. O Scribus 
lida com colunas de modo ligeiramente 
diferente de outros aplicativos de DTP 

– voltaremos a falar disso mais adiante 
– mas o design é efi ciente e bastante uti-
lizável. Edições anteriores do Scribus 
não podiam lidar com caixas de texto 
em diversas colunas. O diagramador era 
obrigado a usar ligações de caixas de 
texto, uma técnica para fazer com que 
o texto passe de uma caixa para outra, 
mais comumente empregado para colo-
car texto em duas páginas separadas.

A caixa de diálogo New Document 
traz algumas outras opções: “Automa-
tic text frames” (Caixas de texto auto-
máticas) coloca uma caixa de texto na 
área de impressão de cada nova página, 
o que é prático para a criação de docu-
mentos longos, como um livro, mas não 
é relevante aqui.

As outras opções relacionam-se à 
imposição: “Facing Pages” cria layouts 
para páginas duplas – certifique-se 
de que essa opção esteja marcada. A 
seguinte é “Left Page First” (Página 
Esquerda Primeiro). Essa opção 
demanda alguma explicação.

Quando as páginas são impressas, 
estão em pares. A primeira página e a 
contracapa estão juntas e são dobra-
das no meio; entre elas é posto o par 
seguinte e assim por diante. O East Bel-
fast Observer permanece relativamente 
constante com cerca de 48 páginas por 
edição, de forma que as páginas um 
e quarenta e oito fi cam lado a lado. A 
página um deve estar do lado direito.

Se quiséssemos desenhar as pági-
nas um e quarenta e oito simultanea-
mente, escolheríamos Left Page First, 
lembrando que a página esquerda será 
a contracapa e a da direita a primeira 
página. Mas não trabalharemos dessa 
maneira; deixe a opção desmarcada.

Um jornal completo compõe-se 
de diversos arquivos que variam em 
número de páginas, em vez de um só 
arquivo que contenha todo o jornal. Não 
apenas isso permite que páginas dife-
rentes sejam produzidas em momentos 
diferentes (e por pessoas diferentes) 
como impede que os arquivos do Scri-
bus se tornem desajeitadamente grandes 

– gráfi cos de alta resolução são pesados, 
ainda mais se estiverem reunidos num 
único arquivo!

Layout Baseado em Caixas
Alguns comentaristas do código aberto 
se queixaram da interface do Scribus, 
dizendo que não é adequada para o usu-
ário doméstico (é uma estranha crítica 
para um software feito para uso profi s-
sional). Tanto o QuarkXPress quanto o 
Adobe InDesign parecem sem dúvida 
muito pouco intuitivos para um amador, 
mas editoração eletrônica é um trabalho 
complexo – não é como processamento 
de texto.

Um problema maior do Scribus é o 
fato de que não há um binário estável 

– e universalmente compatível – dispo-
nível. É ridículo esperar que diagrama-
dores e jornalistas compilem programas 
a partir do código-fonte; isso será um 
sério impedimento à potencial adoção 
do Scribus pela indústria. Acredite ou 
não, há centenas de publicações sem 

departamento de TI; com um sistema 
baseado em Mac elas simplesmente não 
precisam de um suporte interno.

A principal objeção ao Scribus quanto 
à interface inadequada ao usuário 
doméstico parece ser o seu uso de dois 
modos de operação: o layout é baseado 
em caixas, ou seja, cada objeto está 
contido numa caixa e pode ser manipu-
lado de duas maneiras – como objeto ou 
como conteúdo.

Entretanto, esse método de trabalhar 
é comum tanto ao Quark quanto ao 
InDesign e é de fato um modo muito 
efi ciente de separar design de conte-
údo. Além disso, é essencial que o Scri-
bus ofereça um ambiente confortável 
para profi ssionais da imprensa, sejam 
diagramadores, jornalistas ou editores-
assistentes, se quiser fazer incursões 
sérias na editoração.

Uma vez que você se acostuma, o 
modo de trabalhar se torna bastante 
produtivo: para colocar texto na página, 
você deve criar primeiro uma caixa de 
texto e em seguida digitar texto nessa 
caixa. Para colocar uma imagem na 
página, crie uma caixa de imagem e 
importe a foto ou gráfico para essa 
caixa. As caixas e o conteúdo podem 
ser manipulados independentemente.

Gerenciamento de Cores
A impressão é tanto uma arte quanto 
uma ciência; é perfeitamente possí-
vel saber tudo sobre ela e ainda cau-
sar tragédias na impressão. Há muitas 
variáveis para se fi car absolutamente 
confi ante e muitas delas não podem ser 
controladas a partir do computador. A 
gramatura e o tipo de papel usado, a 
quantidade e viscosidade da tinta, o 
tipo e a idade da impressora e a habili-
dade dos impressores também terão um 
efeito maciço no resultado fi nal.

Uma das áreas mais difíceis de acertar 
é a reprodução de cor e, embora todos 
os problemas acima possam ter impacto, 
é importante assegurar, antes de man-
dar os arquivos para a gráfi ca, que eles 
tenham a maior qualidade possível.

A cor é um assunto surpreenden-
temente complexo. O gerenciamento 
integrado de cores era uma das maiores 
vantagens do Macintosh como plata-
forma para produção de impressos em 
geral – e uma das maiores desvantagens 
do Linux. Até agora.

Apesar da primazia do Quark na indústria 
da diagramação, alguns jornais estão 
migrando para outras soluções. O já fale-
cido Dublin Daily usava o Adobe InDesign, 
assim como a revista da Condé Nast, Cosmo 
Girl, e a própria Linux Magazine Brasil.

Até recentemente, não se conhecia 
nenhuma publicação que usasse o Scribus, 
mas isso começa a mudar. O Twin Tier 
Times, um pequeno jornal semanal distri-
buído no sul do estado de Nova York e no 
norte da Pensilvânia, desenvolveu um fl uxo 
de trabalho que não apenas incorpora o 
Scribus como é, na verdade, baseado nele, 
não usando nenhum outro aplicativo de 
layout. De acordo com a equipe do Scribus, 
dois outros jornais estão usando o pro-
grama para a produção cotidiana.

Scribus em uso
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O gerenciamento de cores é uma tec-
nologia usada para calibrar a cor dos 
dispositivos de entrada, exibição e saída. 
O princípio chave é aquele do “espaço 
de trabalho”. É uma referência de cor 
que não está ligada a nenhum dispo-
sitivo específi co, comumente “sRGB”, 
um perfi l básico de cores aditivas ade-
quado para a maioria dos monitores. O 
problema com isso é que o dispositivo 
de saída, seja o monitor ou uma impres-
sora, deve fazer a transformação de 
sRGB para seu espaço de cor nativo; a 
qualidade e precisão dessa transforma-
ção será ditada pela qualidade do driver 
do dispositivo.

Um método melhor é o uso de um 
sistema de gerenciamento de cores 
compatível com o normatizado pelo 
Consórcio Internacional de Cor (Inter-
national Color Consortium, ICC). O 
ICC defi niu um padrão aberto para um 
Módulo de Comparação de Cores, pre-
ferencialmente definido no próprio 
sistema operacional, e perfi s de cores 
tanto para os dispositivos quanto para o 
espaço de trabalho.

A tecnologia de gerenciamento de 
cores pode ser implementada no sistema 
operacional, na API ou diretamente 
num aplicativo. Por anos, o Mac OS 
incluía o programa de gerenciamento 
de cores da própria Apple, o ColorSync. 
Agora o Linux tem uma solução compa-
tível na forma do LittleCMS. Os usuários 
domésticos podem não precisar instalar 
o LittleCMS, mas para fi ns profi ssionais 
ele é imprescindível.

O LittleCMS inclui perfi s de cor ICC 
padrão e por isso, com o LittleCMS ins-
talado, os arquivos PDF produzidos no 
Scribus serão impressos exatamente 
da forma como aparecem na tela. Sem 
isso você teria de adivinhar como uma 
determinada cor vai sair na impressão.

É importante notar que o LittleCMS 
não é um aplicativo em si, mas uma 
biblioteca que pode ser usada no desen-
volvimento de aplicativos. O  Scribus é 
um exemplo. Se você o instalar antes do 
Scribus, ele o usará automaticamente.

Infelizmente, no Linux, o único edi-
tor importante de imagens bitmap que 
suporta o gerenciamento de cores é o 
Corel PHOTO-PAINT. Esperamos que a 
disponibilidade do LittleCMS encoraje 
os desenvolvedores do GIMP a subir a 
bordo o quanto antes.

O aspecto mais importante da utiliza-
ção de um sistema de gerenciamento de 
cores é lembrar-se de ativá-lo! Quando 
chegar a hora de exportar os PDFs 
defi nitivos, falaremos disso em deta-
lhe; neste momento, vamos dar uma 
olhada em File>Export>Save Page as 
PDF (Arquivo>Exportar>Salvar Página 
como PDF). Na caixa de diálogo que 
aparece, escolha a aba cor. Se você tiver 
o LittleCMS instalado, verá um menu 
drop-down em PDF/X-3. Esse menu con-
tém os perfi s de impressão – consulte 
sua gráfi ca e escolha o adequado.

No caso deste jornal, o perfi l correto 
é Euroscale Uncoated v2. Euroscale 
é uma tentativa de fazer um perfi l de 
impressão genérico para toda a Europa. 
Também estão disponíveis as opções 
norte-americana e japonesa, respecti-
vamente  Web/SWOP and Japan Color. 
Uncoated refere-se ao tipo de papel; 
muitas revistas são impressas num caro 
papel couché, mas não os jornais.

Para saber por que o gerenciamento 
de cores é essencial, é preciso compre-
ender os princípios básicos da impres-
são em offset, já que é bastante diferente 
da impressão com jato de tinta.

A impresão em offset, ou litografi a, é 
o processo pelo qual se imprimem jor-
nais. Os arquivos passam por um RIP 

(Processador de Imagens Raster), que 
converte o layout numa imagem Post-
Script. Cada página se torna uma única 
imagem, que em seguida é passada para 
fi lme e transferida para uma chapa de 
alumínio.

Essa chapa é fi xada num tambor e 
rolada na água, que adere às áreas nega-
tivas da imagem. Em seguida a chapa é 
rolada em tinta, que adere às áreas posi-
tivas; depois, um tambor coberto de 
borracha é rolado sobre a chapa, espre-
mendo a água e recolhendo a tinta. Esse 
tambor é então rolado sobre  o papel, 
transferindo para ele a tinta.

A cor é impressa separando-se as cores 
em quatro chapas únicas, uma para 
cada cor usada no processo de impres-
são. Esse processo é chamado separação 
de cor. Para que funcione corretamente, 
elementos coloridos como fotografi as 
ou gráfi cos devem estar no universo de 
cores CMYK. Imagens na tela do com-
putador normalmente estão no formato 
RGB, Vermelho (Red), Verde (Green) e 
Azul (Blue). Essas são as cores primá-
rias aditivas usadas para formar cores 
secundárias e terciárias com a luz.

Com tinta, é necessário usar as pri-
márias subtrativas, Vermelho, Ama-
relo e Azul. Na impressão, essas cores 
são substituídas por Magenta, Ama-
relo e Ciano, que oferecem uma gama 
maior de cores imprimíveis. A ordem 

Antes do estágio RIP, exportaremos nos-
sas páginas como arquivos PDF. O PDF da 
Adobe tornou-se o formato padrão de troca 
de documentos para impressão; se o seu 
arquivo PDF for criado apropriadamente, 
será impresso corretamente numa série de 
dispositivos de saída, incluindo impressoras 
jato de tinta, digitais e impressoras off-set 
de quatro cores.

Saída

Figura 4: O Nome do East Belfast Observer.
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em que as cores são impressas é: Ciano, 
Magenta e depois Amarelo – CMY. O “K” 
é de Key (Chave), que é a cor de registro, 
Preto. Sem a chapa preta fi nal, o resul-
tado seria que os elementos “pretos” 
como o texto fi cariam marrom escuro, 
roxos ou verdes.

Se você imprimir um arquivo RGB 
numa impressora jato de tinta, algu-
mas cores fi carão “fora da escala”, ou 
seja, fora do raio de cores imprimíveis. 
É chato, mas não é um desastre.

Se o seu dispositivo de saída é uma 
impressora CMYK, é fundamental 
mapear apropriadamente as cores RGB 
vistas na tela para cores imprimíveis na 
escala CMYK.

Além disso, se você enviar arquivos 
RGB através do RIP, ele não irá reco-
nhecê-los como imagens coloridas e 
as imprimirá num só fi lme. Resultado: 
imagens particularmente sombrias em 
escala de cinza.

Usar cores CMYK signifi ca que você 
não vai terminar acidentalmente com 
uma página monocromática; utilizar 
gerenciamento de cores signifi ca que as 
cores que você vê em suas provas serão 
exatamente iguais ao resultado fi nal.

Elementos da Página
As páginas de um jornal ou revista con-
sistem em três elementos básicos: texto, 
imagens e espaços em branco. A pro-
porção de cada um dependerá do seu 
projeto gráfi co – anúncios são bem dife-
rentes de conteúdo editorial e páginas 

editoriais variam de publicação para 
publicação e mesmo entre diferentes 
seções de uma mesma publicação.

Com algumas exceções notáveis, 
como o Libération francês e o Guardian 
inglês, o projeto gráfi co dos jornais é 
bem pouco inspirado. Isso não quer 
dizer que os jornais sejam necessaria-
mente mal-projetados, apenas que os 
critérios são diferentes dos de outras 
áreas do design gráfi co.

Os dois aspectos fundamentais do 
projeto dos jornais são: facilidade de 
leitura e facilidade de layout. O pri-
meiro é importante porque um jornal 
deve ser digerido rapidamente por um 
leitor médio, não por um especialista. 
Se o projeto for consistente e conformar-
se com certas regras básicas, a tarefa 
de leitura será facilitada. O segundo 
aspecto é importante porque, diferente 
das revistas, que em geral têm uma edi-
ção por mês, os jornais normalmente 
são diários e a equipe de layout sofre 
uma pressão bem maior.

Para nosso jornalzinho, o primeiro 
elemento da página é o nome (ver fi gura 
4). Chamado com freqüência – e erro-
neamente – de cabeçalho, ele é o nome 
do jornal, exibido no topo da primeira 
página. Neste caso, o estilo das fontes 

utilizadas é Gill Sans Light Italic e Gill 
Sans Bold Condensed.

Para este jornalzinho, nosso nome 
é um arquivo TIFF de alta resolução 
criado no Inkscape, exportado e con-
vertido para TIFF de 1 bit em resolução 
de 600dpi (ver fi gura 5). 600Dpi é uma 
resolução incrivelmente alta, especial-
mente se considerarmos que a prensa 
usada terá por volta de 180 dpi; por que, 
então, preocupar-nos com uma resolu-
ção tão alta?

Arquivos que usam um universo de 
cores de 1 bit são preto e branco; não 
escala de cinza, mas literalmente preto 
e branco. Em geral, TIFFs de 1 bit são 
usados para arte linear (line art). A van-
tagem de usar um universo de cores de 1 
bit é que a cor das linhas (ou, em nosso 
caso, do tipo) pode ser mudada dentro 
do aplicativo de layout da página, de 
forma que um único arquivo fonte pode 
ser usado para múltiplas variações da 
mesma imagem. O lado ruim das ima-
gens de 1 bit é que elas fi cam piores em 
altas resoluções – mesmo a 300 dpi uma 
imagem de 1 bit começará a mostrar 
contornos serrilhados.

Para importar a imagem com o nome 
de nosso jornal, selecione Insert Picture, 
o terceiro ícone na barra de ferramentas, 

Analisando por alto o mercado, podemos inferir que há relativamente poucos pacotes de editoração 
eletrônica no Linux, mas isso não é bem verdade. Talvez eles estejam enterrados sob a montanha 
de programas de composição baseados em linha de comando, como o TeX e o tradicional utilitário 
UNIX Troff e seu derivado GNU, o Groff, mas existem várias boas ferramentas DTP com ambiente 
gráfi co para Linux.

O principal aplicativo comercial é o PageStream. Desenvolvido pela Grasshopper LLC nos EUA, o 
PageStream teve origem no Amiga, nos anos 80; mas a chave-de-braço que o Apple Macintosh 
deu na indústria da editoração acabou fazendo com que ele nunca se difundisse no campo pro-
fi ssional. Em vez disso, o PageStream encontrou um nicho entre as pequenas publicações, como 
grupos comunitários e jornaizinhos de igreja; mesmo assim, é um aplicativo de qualidade pro-
fi ssional e está disponível não apenas em versões para o Amiga OS e Linux, mas também para 
Windows, Mac OS X e em duas plataformas um pouco exóticas: MorphOS e Amiga PowerPC.

No fi nal de 1999 a Adobe lançou uma versão beta do FrameMaker para Linux. Não tendo conse-
guido se popularizar no Mac, o FrameMaker é usado para criar documentos científi cos e técnicos. 
Atualmente, está disponível apenas para Windows, Mac e Solaris/SPARC mas, demonstrando a 
intenção da Adobe de limitar o FrameMaker apenas ao mercado de publicações técnicas, ele não 
será mais desenvolvido para Mac OS. O que espanta é que a Adobe não continue a desenvolver o 
FrameMaker para Linux – um mercado obcecado por documentação técnica.

Se você está determinado a usar apenas software de código aberto, duas outras opções são o 
Xclamation e o Passepartout.

O Xclamation, desenvolvido pela Axene como parte da suíte de escritório Axena, é um aplicativo 
de DTP completo, que usa o conjunto de ferramentas Motif e, por isso, roda virtualmente qual-
quer sistema UNIX.

A outra alternativa é o Passepartout. Enquanto o Scribus é um aplicativo KDE, o Passepartout é 
um aplicativo nativo do Gnome para quem prefere o look and feel dessa plataforma.

Um terceiro, quarto e quinto modos.

Figura 5: Após exportar a imagem a partir do 
programa de desenho – em nosso caso o Inks-
cape – abra-o no GIMP e transforme-o numa 
imagem de 1 bit selecionando Image>Mode>Inde-
xed(Imagem>Modo>Indexado). Escolha a paleta 
Preto e Branco (1 bit).
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e desenhe uma moldura 
por toda a largura da área 
de impressão entre as 
duas margens da página.

A segu i r, vá em 
File>Import>Get Pic-
ture. Após selecionar o 
arquivo apropriado, cli-
que em Tools>Properties 
para abrir a caixa de 
diálogo Properties (Pro-
priedades) do Scribus 
(fi gura 6) e escolha Image. 
Selecione a opção Scale 
to Frame Size (Ajustar à 
Janela), sem esquecer 
de marcar o botão “pro-
portional”. O nome deve 
fi car então da largura da 
primeira página do jornal, 
excluindo as margens.

Acima do nome há três 
quadros, que destacam o 
conteúdo do jornal. Esses quadros são 
caixas de imagem vazias que foram 
coloridas usando a caixa de diálogo 
Tools>Properties>Colors. Diretamente 
abaixo do nome estão a data e o número 
da edição do jornal, assim como o preço. 
Ambos são criados como elementos de 
texto no Scribus da maneira normal. 
Também é possível criar o nome como 
uma caixa de texto normal dentro do 
Scribus, mas como ele é um elemento 
imutável, é melhor usar um arquivo 
gráfi co, para evitar que algum erro de 
digitação possa se infi ltrar por ali.

O próximo elemento a incluir é o texto. 
Em termos de entrada de texto, é pouco 
efi ciente digitar diretamente no Scri-
bus. Mesmo com um monitor grande, 
você vai perder um tempão mudando 
o zoom para ler trechos das páginas. 
Além disso, num jornal, quem diagrama 
geralmente não produz as matérias. Em 
vez disso, prepare todo o texto num 
processador como o OpenOffi ce Writer, 
faça a correção ortográfi ca e importe-o 
para o Scribus.

O texto deve ser salvo como texto 
puro antes de ser importado. O Scribus 
não pode importar nenhuma forma de 
texto formatado, seja Rich Text For-
mat (RTF) ou formatos nativos do  
OpenOffi ce. Isso logo deve mudar – os 
desenvolvedores do Scribus estão traba-
lhando na importação de RTF, que teria 
a vantagem de importar toda a formata-

ção, como negrito, itálico 
e assim por diante, junto 
com o texto.

Discutiremos a forma 
de trabalhar com texto 
mais profundamente nas 
próximas edições; vamos 
nos concentrar agora em 
colocar algum texto em 
nosso projeto.

Colocar o texto é bem 
simples: clique no botão 
Insert Text Frame (inserir 
caixa de texto) na barra 
de ferramentas do Scribus 
e desenhe uma moldura 
na página, mais ou menos 
onde você quer que o 
texto fi que. A seguir, sele-
cione File>Import>Get 
Text. O texto do arquivo 
escolhido passará para a 
moldura selecionada.

Para editar o texto, selecione Edit 
Contents of Frame (editar conteúdo da 
caixa) na barra de ferramentas e use o 
cursor para selecionar palavras e frases, 
como num processador de texto normal. 
Alternativamente, o  item Story Editor 
(também encontrado na barra de ferra-
mentas) pode ser usado.

Como indicado acima, os modelos 
de página em editoração são bem mais 
básicos que em outros aplicativos. Em 
geral não incluem informações como 
fontes, espaçamento ou se estilos como 
negrito ou itálico serão usados.

Conclusão
Este artigo lhe apresentou o Scribus, 
um software Open Source para layout 
e editoração em nível profi ssional. Nos 
próximos meses, você irá aprender mais 
sobre o gerenciamento de texto e ima-
gens no Scribus. ■
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Figura 6: A caixa de diálogo 
Properties do Scribus, onde 
você pode ajustar quase todos 
os aspectos de um objeto.


